Ox< ICHAS

Irish College of Humanities & Applied Sciences

STUDENT INFORMATION SERVICES (IS)

INTRODUCTION

This manual will provide students with details and instructions on how they can engage with the college’s
range of Information Services. This manual can be used to access information on the following IT based

services:
1. Moodle (LMS) Learning Management System
2. Library Services
3. Adobe Connect (Live and Recorded Lectures)
4. College WiFi Services
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IT REQUIREMENTS STUDENT IT REQUIREMENTS

Hardware

Below are the specification for Desktop or Laptop Computers recommended for login to ICHAS Information
Systems and Adobe Connect Live Lectures. Although some hand held mobile devices support the use of Adobe
Connect and other IS, the college will not endorse their use for our Blended Learning environment and will not
be able to provide technical support for their use.

Windows based Laptops and Desktops
e 1.4GHz Intel® Pentium® 4 or faster processor (or equivalent) for Microsoft® Windows 7,
Windows 8, Windows 8.1 or Windows 10

e Windows 8.1 (32-bit/64-bit), Windows 8 (32-bit/64-bit), Windows 7 (32-bit/64-bit),
Windows 10 (32-bit/64-bit)

e 1GB of RAM (2GB recommended) for Windows 7, Windows 8, Windows 10
e Google Chrome, Microsoft Internet Explorer 9 or later; Mozilla Firefox;

e Adobe® Flash® Player 11.2+

Mac OS based Macbooks and Desktops

e 1.83GHz Intel Core™ Duo or faster processor
e 1GB of RAM (2GB recommended)

e MacOSX10.8,10.9,10.10

e Google Chrome, Mozilla Firefox; Apple Safari;

e Adobe Flash Player 11.2+

Linux based Laptops and Desktops

e Ubuntu 14.04; Red Hat Enterprise Linux 6; OpenSuSE 13.1
e No Add-in support for Linux. Users on Linux can attend meetings in the browser.
e Google Chrome

e Adobe Flash Player 11.2+

Mobile

e Avariety of devices can run Adobe Connect but are not supported for Blended Learning by
ICHAS. You should first test any devices you intend using with our services.
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Additional Requirements

Headsets

ICHAS requires that, regardless of the computer you are using, you use a combination headphones
and microphone Headset when engaging with Live Adobe Connect Lectures. These headsets reduce
background noise, interference, feedback, and greatly enhance the user experience of live broadcasts
with two way communications.

Web Cam

Although not essential, a web cam will afford you the opportunity to further enhance your
engagement with live lectures when opportune.

Broadband

1Mbs+ Fibre/DSL/Cable Broadband (Wired connection preferred to WiFi). (Please ensure you test
the speed of your connection for the times that live lectures will be broadcast to make sure you can get a

minimum download speed of 512Kbs+)

Mobile Broadband connections of similar speeds to the above may be used but are not
recommended as they have proved less than reliable in the past. There use will require a little
trial and error to see if they are suitable for your situation.

Adobe Connect software includes support for the following languages: Brazilian Portuguese, Chinese Simplified,
Dutch, English, French, German, Italian, Japanese, Korean, Russian, Spanish, and Turkish.

SUPPORT

ICHAS IT Support staff will be on hand during the Induction period to answer any technical queries you may
have and to advise on equipment choice and purchase if required.

You will receive a guide to using Adobe Connect and a number of
“Trial Lectures” will be broadcast over two weeks pre-semester to
allow you the opportunity to test your equipment and settings. It is
strongly advised that you avail of this service to avoid any problems
during real live broadcasts.
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MOODLE STUDENT MANUAL

WHAT IS MOODLE?

Thoodle

Our Student Portal has been designed using Moodle. Moodle is referred to as a Learning Management System
(LMS), a tool which can support learning in a number of ways, as it facilitates access to notes, discussions,
debates, multimedia content and other educational resources. Moodle is the system upon which the ICHAS
Portal runs, similar to the way your computer might run on a Windows system, or your phone might use an
Apple iOS or Android system. You may hear the terms ‘Student Portal’, ‘ICHAS Portal’ and ‘Moodle’ used
interchangeably.

Moodle is extremely customisable and easy to use, which is one of the reasons it is so popular. It is used not
just at ICHAS but at thousands of educational institutes and corporate environments throughout the world. For
more information on Moodle itself, take a look at the official Moodle knowledge base at www.moodle.org.

To access the ICHAS portal, just go to www.ichas.ie and click on the Student Portal link and type in your
username and password.

ICHAS has introduced a blended learning strategy for some modules
across a variety of programmes. Our Moodle Learning Management
System is an integral part of our Blended Learning Environment and
students should take time to familiarise themselves with all its
facilities

WHAT IS BLENDED LEARNING?

Blended Learning refers to a learning environment that combines the traditional classroom experience with
the delivery of a selection of off-campus content and instruction via digital and online media. Online
presented content allows learners to engage with the theory content of selected modules via broadcasted
interactive live lectures, from the comfort of their own home. Other digital content includes recorded lectures,
pre-recorded presentations and podcasts, courseware and module notes. Learners have access to their tutors
and course content through our online student portal which is easily accessible 24/7 regardless of location.
This innovative and highly effective approach to programme delivery allows learners with work and family
commitments to study at times that suit their needs.

All our programmes require that learners have access to a suitable computer to access digital resources.
Blended modules in particular make greater use of on-line resources and students will be advised of specific IT
requirements for the various programmes. It is, however, important to note that no technical knowledge is
required to engage with Blended Learning material, just basic computer user skills. Our experienced IT staff
will be available to offer support and advice on topics related to your computer and IT requirements.
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LOGGING ONTO THE ICHAS STUDENT PORTAL

To access the ICHAS portal, just go to www.ichas.ie and click on the Student Portal link and type in your
username and password.

1. Enter the username and password you received at Induction.

Usemame |halpin

Password

Forgotten your username or password?

Alternatively:

You can access the login page directly: http://students.ichas.ie/login/index.php

After logging in for the first time, you may be asked to change your
password. Please choose something you will easily remember.

NB: Please DO NOT rely on password storage options within your web browser — always use
a password you can remember independently.
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NAVIGATING THE ICHAS PORTAL: FIRST STEPS

1. THE PORTAL HOMEPAGE

The homepage s the first thing you will see after logging in and it looks like this:

Homew Site pages

1. Student Resources &

Programme Information m

No messages waiting
Messages

P My profile settings 0 use this site

NB Please remember to access your ICPD ooress regularly for all correspondence from the
college, including assignment results. If you need heTp accessing your ICHAS email, please contact Raymond Hill _

%* Blended Leaming via email to raymond.hill@ichas.ie Latest news

Student Orientation 18 May, 10:40
','0 Ethics & Professional Welcome to the ICHAS Portal Jonathan Flynn
Issues 8340 ICHAS Facebook Page
%@ General Information more...

%2 Human Development 23 Apr,16:00
(Limerick) Jonathan Flynn

%= Research and Inquiry Message to College
for Psychotherapy Community more

%.° The Mental Health 3 Apr, 15:59

Continuim Jonathan Flynn

Fiona Hoban CPD
Workshops more...

16 Mar, 10:15

=sonathan Flynn
Professional Accreditation
Webinar more...

Older topics ...

%* Theoretical Perspective
in Counselling and
Psychotherapy

%° Theoretical
Perspectives in
Therapeutic Engagement

in Practice
All courses ...
A (last § minutes)
2. Your (2 Jonathan Fiynn E]
modules

2. RESOURCE INFORMATION

This is the main Portal area. Access to all relevant College information is available through this main page.
Below is a Summary of the important areas within this site :

a. Student Services — Information relating to Administration Team, Student Forms, Student
Handbook, Services for Disabled Students, Garda Vetting etc.

b. BA Programmes — Information relating to all BA and BA (Hons) Programmes.
c. MA Programmes - Information relating to all MA Programmes.
d. Lifelong Learning — Information relating to all Certificate and Bespoke Programmes.

e. Exams and Assessments — Information relating to Exams and Assessments e.g.Regulations,
Forms, Support, Guidelines etc

f.  Library — Access to Online Library

g. Fees and Student Finance — Information relating to Tuition Fees, Examination Fees,
Registration Fees, funding, application forms, invoices and receipts

h. Career and Professional Development — Information relating to careers and further
development opportunities in the areas of counselling and psychotherapy

i. Student E-Mail — Not available until 15t August
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3. LIST OF MODULES

At the left of the page are some of the modules you are enrolled on. Click
My courses r - o

on the module name to visit the module homepage where you will find
%e Demo Course 2012 resources like notes, assighment outlines and assignment upload utilities.

%@ Ethics & Professional
lssues Galaay

%@ General Information
T& Health Promaotion
(Denis Ryan)

J

If you can’t find one of your modules in this list, then click on “My Courses’
at the top of the screen

- . Figure 1 Click on "My Courses” at the top of the homepage to view all of your modules
o® ICHAS Demonstration
Courze

"® Practice Placement- 4. YOUR PROFILE
Students (Level 8)
Te Psychopathology

(3358
All courses |

You will also see a link called “Update
Profile” at the top of the page. You can change your email address or personal picture within this section if you
wish.

IMPORTANT: Any updates which you do on the Moodle system will not be captured on our record system. If

you wish to change your surname, your address or your email, please contact your programme coordinator
on 061 216288 so that the request can be processed via the Office of Academic Administration and Student
Services.

NAVIGATING THE ICHAS PORTAL: MODULE HOME PAGES

As mentioned above, click on the link to a module on the left hand side of your Homepage, or by clicking on
My Courses to go to a module homepage.

1. WHAT ARE MODULES?

Modules: Modules are the components which make up your programme. You usually have 6-8 modules per
academic year, with 4 modules per semester. The example below outlines how Year 1 of the BA in Counselling
Skills and Psychotherapy Studies might be structured, with 4 modules in each semester.

BA Counselling Skills and Psychotherapy Studies Year 1 - Semester 1 (4 Modules)
Ethics & Professional Issues
Counselling & Psychotherapeutic Skills & Practices 1
Theoretical Perspectives in Counselling & Psychotherapy
Human Development

BA Counselling Skills and Psychotherapy Studies Year 1 - Semester 2 (4 Modules)
Research and Inquiry for Counselling & Psychotherapy
Theoretical Perspectives in Therapeutic Engagement in Practice
The Mental Health Continuum
Introduction to Personal Development

You will have a module homepage for every module you are enrolled on, so be sure to visit them often. Your
lecturer will inform you how they will be using the Portal at the beginning of each module.
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Blended Learning Modules: Blended learning modules are delivered in part through their module homepages,
so it is a requirement of these modules that you log in very often and engage with the online learning and
assessment activities available on the ICHAS Portal.

2. NAVIGATING MODULE HOMEPAGES

Module home pages are usually subdivided into LESSONS, TOPICS or DATES.

S Irish College of Humanities & Applied Sciences

m Topic outline Calendar

< September 2011 »

F My profie settings

) Module Descriptor Sun Mon Tue Wed Thu Fri Sat
[ Practice Discussion Forum

' LESSON 1: Moral Philosophy in relation to Gounselling & Psychotherapy - Toggle "

W LESSON 2 will be availble shortly - Toggle Tee Events key

T

/

Click on the grey arrow to expand each lesson/topic/date and access the resources. The lesson will expand as
in the image below. Each item in this example represents a resource such as links to website, pdf documents,
narrated lectures etc.

There are various different types of resources or activities you might see, depending on what your lecturer
decides to use to deliver content to you. Some of the most common types, and their associated icons, are
presented in the image below.

Moodle Icons
‘ ~ Q Chat Icon: Indicates a chat room where students can discuss topics in real time.

| = D’ OR 7-_'“ File Icon: A single file to open or download. May be a PDF, Word document, image or other
file type. PDF files may also display this icon: T_“

Folder Icon: Opens a folder which contains a collection of resources on a particular topic.

Discussion Forum Icon: Click to open discussion forums
Glossary Icon: Link to a glossary of terms that might be maintained by students or lecturers
Quiz Icon: Opens a quiz for testing/reviewing knowledge

URL icon: This icon indicates a link to content elsewhere online, e.g. another website for
relevant information, a video on YouTube, etc

) G
@ Assignment Upload Utility: When you see this icon, it means you can click to go to an
assignment upload page
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3. ACCESSING MODULE RESOURCES

Within the module homepage, click on the recourses that you would like to open e.g. file, discussion topic,
folder etc.

Most resources such as videos, pdf files and word documents will open in a new window. To go back to your
module screen just click the back arrow on the internet browser. When a document such as a PDF opensin a
new window, once you close the window you will be back at your module screen.

Please note that as stated on your application form, the ICHAS portal is optimised for use on a Windows-based
operating system. As such, users who attempt to open resources on a smartphone or touchscreen tablet
comptuer using Android, Windows Phone or Apple iOS may encounter some difficulties.

SAVING RESOURCES

If you wish to save files to your computer or laptop, you can do so by saving the file when it is opened. Select
the location where you wish to save your file such as “My documents”, click on save. You can then view the
document when you are offline or logged out of Moodle.
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USING DISCUSSION FORUMS

Unlike a resource, an activity is interactive - think of it as “things you do.” It allows you to interact
with your lecturer and with other students. This example shows you how to post a message to a
discussion forum, a common activity for Blended Learning modules in particular.

1. Click the name of the discussion topic. The icon for forums will appear next to its description. Below is
sample of a discussion forum as it appears on the course content.

_:f'& Practice Discussion Forum

2. Toread the topic, click on the discussion topic as above.

Practice Discussion Forum
by Admin User - Thursday, 29 September 2011, 04:09 PIM

This is a practice discussion that will be used during the induction day. This will be
deleted after the induction.

Reply

3. Press reply, then type your answer, select the spell check icon and then click on post to forum.

Practice Discussion Forum
by Admin User - Thursday, 29 September 2011, 04:08 PM

This is a practice discussion that will be used during the induction day. This will be
deleted after the induction.

rYour reply

Subject™ |Re: Practice Discussion Forum

Message™ Font family |~ | Fontsize ~ || Paragraph gl [ .ﬁ"'br =
Jl.ﬁ].ﬁ]é'ﬁ' LS B ]
EAEQE -

B 7 U #¢ X, x*

e
==
1=

i
il

Thi is a test response.

Path: p
HTML format [+ |

Subscription | Sand me email copies of posts to this forum E|

Attachment [Add.| Maximum size for new files: 500KB
No files attached

Post to forum

There are required fields in this form marked™®

IMPORTANT: You may prefer, and indeed we strongly advise, that you write your responses in a word
processing package such as MS Word and save it offline first before copying and pasting it to the discussion
forum. This will allow you to keep a record and resubmit in the event that your internet goes down during

submission.
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Uploading Assignments for Correction

2. Loginto the Student Portal at http://students.ichas.ie using the username (student number) and
password provided to you.
3. Click on the My Courses link on the left of the page to access the Courses
area. My courses
4. Click on the module that you wish to submit the assignment. In the All courses
examples to follow, the Bereavement module has been selected, as in
the figure below.
5. Onthe next screen, you will see the assignments associated with your module (these are at the top of
the module content area).
Weekly outline
g News forum
T Bereavement Module Descriptar
Assignment details icon T Bereavement Module Assignment Assigrment Details
T Bereavement Module Marking Guidelines _
Assignment upload icoﬂ:j}% Submit Your Assessment Here (Essay Due Friday 17th Februar'_-,r}'l— Lick '

6.

Assignment Details are contained in the files labelled Assignment Details in the above screen-shot.

To submit your assignment, click on the
i Lo . Please refer to Guidelines Above for Assignment Details.
relevant assignment submission link. You can
recognise the link by the assignment upIoad All files uploaded will be submitted to a plagiarism detection semnice
icon, as above. In the above example the link is Due date: Friday, 17 February 2012, 04:00 PM
titled “Submit Your Assessment Here (Essay
Due Friday 17t February)”, with the

. . [o file bmitted yet
assignment upload icon to the left. When you Upload files

click on the submission link, you will see due Notes

Submission

date information and an upload file button as No entry
in the screenshot below. To upload your file
click on the Upload files button.

8. The following screen will be displayed. Click the Add button.

Upload a filg Create folden Maximum size for new files: 1MB
Mo files attached

[Save changes [Cancel
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9. The file picker tool will open, as below. Select Upload a file from the left hand side, as below. Click
Choose a File and select your assignment file from your PC/Laptop or USB Key. You must know where
you have the file saved to be able to locate and upload it. Your name will automatically appear in the
Author field. Select Upload this file to complete the upload.

File picker *

T Server files

T Recent files Attachment: Choose File o file chosen

Sawve as:

l@. Upload a file

Author:  |ICHAS Student

1 Private files Choose license: | All rights resernved E|

T — Select “Upload this file” to

1inlnad to the nartal

10. When you have uploaded your assignment, its name will apppear as in the example below, where the
assignment name is “Accounting.docx”. Click on “Save Changes” to proceed.

Upload a file Path: Files
IAdd..| [Create folder [Download all Maximum size for new files: 1MB

] Accounting.docx B

\Save changes| [Cancel
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11. When you are satisfied that your assignment is complete, you MUST click on Send for Marking to
complete submission, as in the picture below.

IMPORTANT: Clicking on Send for Marking completes the upload process. Once you click on Send for
Marking, the assignment cannot be edited or replaced.

Only click on Send for Marking if you are sure you are completely finished your assignment and wish to
submit it to the assessor for marking.

The Social Cultural and Political Issues Assignment is due

Friday 16th March 2012 at 4.00pm

All files uploaded will be submitted to a plagiarism detection service
Available from: Friday, 2 March 2012, 09:00 AM
Due date: Friday, 16 March 2012, 05:00 PM

Submission draft

] Test. docx After you have uploaded an

Editthese files assignment, you must then click on

the "Send for Marking” button to
Notes complete submission.

Final submission for assignment marking

No entry

Send for markmg
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REPLACING AN UPLOADED ASSIGNMENT

IMPORTANT NOTE: If you want to remove an already-uploaded file and upload a new one in its place, you may
only do so in the following circumstances:

i. before the submission deadline
ii. before completing Step 11 (see above)

12. To replace an uploaded file, click on the Edit these files button.

Please refer to Guidelines Above for Assignment Details.

All files uploaded will be submitted to a plagiarism detection semnice

Due date: Friday, 17 February 2012, 04:00 PM

Submission

5----@] Accounting.docx

Edit these files

Notes

Mo entry
Edi

13. Select the icon after the file name. Select delete and then follow Steps 7 - 11 above to upload the
new/replacement file.

Upload a file Path: Files
|Add..| [Create folderd [Download al| Maximum size for new files: 1MB

] Accnunting.dncd =}

Download
Rename...
Move. ..
Dealete...

[Save changes| [Cancel

IMPORTANT NOTE
You cannot submit assignment via the portal after the assignment due date / time.

You must send late assignments via post to:
ICHAS Exams Dept

Walton House

Lonsdale Road

National Technology Park

Castletroy

Limerick
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FREQUENTLY ASKED QUESTIONS - ACCESSING THE ONLINE PORTAL

WHAT DO | DO IF | FORGET MY PASSWORD?

1. If you forget your password, follow the steps above in ‘How do | Access the Online Portal?’
2. Type your username into the login area and press ‘Forgotten your username or password?

| HAVE LOGGED INTO THE ONLINE PORTAL BUT MY MODULE DOES NOT APPEAR
ON THE COURSE LIST TO THE LEFT HAND SIDE. WHAT SHOULD | DO?

1. All students are automatically enrolled on to the appropriate modules for that semester.
2. If you cannot see your modules here, or if you are enrolled on the wrong modules, then please
contact your relevant Programme Coordinator as follows:

Anne Conlon (Level 6/7/8— Undergraduate Degree Programmes)
Roisin Taaffe (Level 9 — Post Graduate & Masters Programmes)

WHAT ARE COOKIES AND WHY DO | HAVE TO ENABLE THEM?

Cookies are small text files that websites use to store information about their users. The Online System
(Moodle) uses cookies to store and pass on your username as you move from page to page. If you are
having problems accessing the portal then you may need to configure your browser settings so that your
computer will accept cookies.

How do | enable Cookies?
Enable cookies following the instructions corresponding to the browser that you are using:

Mozilla Firefox

Go to the Tools menu.

Select Options.

Select the Privacy icon in the left panel.

Check the box corresponding to Accept Cookies from sites.
Click OK.

ua p WN

Google Chrome

Click the spanner icon on the browser toolbar.

Select Options (Preferences on Mac and Linux; Settings on a Chromebook).
Click the Under the Bonnet tab.

Click Content settings in the "Privacy" section.

Click the Cookies tab in the Content Settings dialogue that appears:

Make exceptions for cookies from specific websites or domains

ounkwnNE

To control how cookies should be handled for a few specific sites or domains, click Manage
exceptions. To add a rule in the Cookie and Site Data Exceptions dialogue that appears, follow these
steps:

1. Click the "Add a new exception pattern" field and enter the domain name for which you
want to create an exception i.e. http://students.ichas.ie
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2. To create exceptions for an entire domain, insert [*.] before the domain name (e.g.
[*.]google.com).

3. Use the menu to choose whether the site can set cookies. If you select Session only, its
cookies are deleted every time you close your browser. You can also edit or remove
exceptions, using this dialogue.

Microsoft Internet Explorer 6.0+

Select the Tools menu.

Click on the Privacy tab.

Click the Default button (or manually slide the bar down to Medium) under Settings.
Click OK.

5 WN P

WHAT IS A FIREWALL AND WHY MIGHT IT PREVENT ME FROM ACCESSING THE
ONLINE PORTAL?

A firewall protects a computer, or computer network, from access by unauthorized parties. If you are
having problems accessing the portal from home or work then it is possible that your firewall’s
configuration is causing a problem. Please consult your antivirus documentation if at home, or your
network administrator in your place of work. If the problem persists, then please email support@ichas.ie.

| have entered the correct username and password, have cookies enabled, and have confirmed that a
firewall is not blocking access, but | am still having problems

Please email support@ichas.ie
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| CAN ONLY SEE ONE WEEK OR TOPIC OF MY MODULE.

There are a number of reasons for this:

Reason 1

1. You have probably clicked on the show only this week/topic icon L1

]

2. Todisplay all of the other weeks/topics, click on the show all weeks/topics icon Ldin the top-
right hand corner of the week/topic that is visible.

Reason 2

Your lecturer may be releasing content on a weekly basis i.e. on week 2 you may only see content for
week 1 and 2.

HOW DO | MANAGE EMAILS FROM MOODLE FORUMS?

The system forwards you email copies of messages posted to any discussion forums that you are
subscribed to, or of any instant messages sent to you while you are offline.

WHAT DOES SUBSCRIBING TO A FORUM MEAN?
When a person is subscribed to a forum it means that they will be sent email copies of every post in that
forum (posts are sent about 30 minutes after the post was first written).

People can usually choose whether or not they want to be subscribed to each forum.

However, if you choose to force subscription on a particular forum then all course users will be
subscribed automatically, even those that enrol at a later time.

This is especially useful in the News forum and in forums towards the beginning of the course (before
everyone has worked out that they can subscribe to these emails themselves).

If you choose the option "Yes, initially" then all current and future course users will be subscribed
initially but they can unsubscribe themselves at any time. If you choose "Yes, forever" then they will not
be able to unsubscribe themselves.

Note how the "Yes, initially" option behaves when you update an existing forum: Changing from "Yes,

initially" to "No" will not unsubscribe existing users, it will only affect future course users. Similarly
changing later to "Yes, initially" will not subscribe existing course users but only those enrolling later.

You become subscribed to a forum in one of 3 ways:

1. By explicitly doing so;
2. By making a posting to the forum yourself; or

3. If the forum is set so that all members of the course are subscribed (this is an option available
to the lecturer).

Except for the last case you can unsubscribe at any time, and your ability to read messages is
unaffected: 'subscription' only means opting to receive email from the forum.
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You can control the amount and type of email forwarded to you from the portal through adjusting the
settings in your Profile. To access your profile, click on the link to your name in the top right-hand
corner of the site homepage.

| AM HAVING PROBLEMS VIEWING, OPENING OR PRINTING PDF FILES
First make sure you have the latest version of the Adobe Acrobat Reader. You can download and install
the latest version of the Reader from:

http://www.adobe.com/products/acrobat/readstep2.html.

If you continue to experience problems, please email support@ichas.ie
| DON’T OWN A COPY OF MICROSOFT OFFICE

Windows users

If you do not have a copy of Microsoft Office on your computer you can download and install a free
viewer for the appropriate file. These will allow you to view, but not to edit, the files:

e Microsoft Word viewer
e Microsoft Excel viewer
e Microsoft PowerPoint viewer

Alternatively, you may want to download the (free) OpenOffice suite.

Mac users
There are no Microsoft viewers available for Mac users without Office.
e Mac OS X users may wish to use OpenOffice.org.
e AppleWorks provides compatibility with Word, Excel and PowerPoint.

e icWord/icExcel Commercial utilities to view/print Word/Excel documents

I AM HAVING PROBLEMS VIEWING, OPENING OR PRINTING WORD, EXCEL OR
POWERPOINT FILES

First of all make sure that you have Microsoft Office, a Microsoft office viewer, or Microsoft office
compatible equivalent, installed.

THE SCREEN GOES BLANK WHEN | CLICK ON A RESOURCE

This may happen if you are using the Internet Explorer browser. This solution alters your browser
settings so that Internet Explorer doesn't open the Office documents within the browser, and instead,
downloads the document and opens it via the appropriate Office application:

1. Double-click My Computer.
2. In the Tools menu, click Folder Options.

3. On the File Types tab, in the Registered file types box, click to select the file type that you want
to change. For example, click to select PPT Microsoft PowerPoint Presentation.

4. Click Advanced.

5. In the Edit File Type dialog box, click to clear the Browse in same window check box, and then
click OK.

6. Click Close to close the Folder Options dialog box.

If you continue to experience problems, please email support@ICHAS.ie
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PROBLEMS OPENING POWERPOINT FILES FROM YOUR MODULE

When you click on the PowerPoint slides in your module to open them, the file seem to start to
download and try to open, but when PowerPoint opens the slides are blank. Please follow the below to

fix this issue:

1. Download and install this update for Microsoft Office. (You can also download this update from

Microsoft here)
2. Once downloaded run the File and step through the install.
3. When the install in complete try opening the PowerPoint files from your portal page again and

this will display the slide now.
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STUDENT LIBRARY SERVICES

Common resources available to all ICHAS students can be found in the Library
section of your Moodle Homepage. Here you will be able to access a number of
significant resource repositories containing a range of books and journal
publications. As well as these directly accessible libraries you will also find links
to a variety of resources on the web, that you may find useful. When you enter
the Library section you will see the following screen:

¥ Database Menu - Internet Explorer [_[=1=]

—— —
Tk @ httpeflibrary.ichas ie: 2048imenu = | I‘_y\ 22 ICHAS Portal {2 Database Menu x AL

Flle Edit wiew Favorites Tools  Help

9% € Welcome ko the eTenders p... 2 | https—owa.student.ichas 2 | Login (3) < | Login (2) 4| My Home Page Login [LJ] Sumaested Sites ~ 2 web sliee callery ~ 2] Jobseeker

A~
)
< [CHAS
Irish College of Humanities & Applied Sciences
. .
Library List
.
Click here to access Psycnet
.
Click here to access DawsonEra
. . . .
Click here to access SciVerse ScienceDirect
Other research sources

4 Ther. “therapy.com is concerned about the stigma attached to seeking professional help for psychological issues and the difficult path most people face when trying to select
[AterEpy la therapist. Our mission is to provide the most trustworthy and reliable way to confidentially identify and select a psychotherapist ideally suited to your needs.
|A Vision for Chanae |A Vision for Change details a comprehensive model of mental health service provision for Ireland. It describes a framework for building and fostering positive mental

lhealth across the entire community and for providing accessible. community-based, specialist services for people with mental illness.

The American Counseling Association is a not-for-profit, professional and educational organization that is dedicated to the growth and enhancement of the counseling
ACA iprofession. Founded in 1952, ACA 1s the world's largest association exclusively representing professional counselors in various practice settings. ACA is the premiere
— lsource for books for cl use and p ional resources for your specialty area. ACA offers a wide variety of publications. DVDs, and other educational

imaterials to support the counseling profession.
IAPA The American Psychiatric Association is a national medical specialty society whose physician members ialize in di is, treatment, pi ion and research of
7 imental illnesses including substance use disorders.
|American Psychological The American Psychological Association is the largest scientific and professional organization representing psychology in the United States. APA is the world's
jamernican Fsychological
|Associati largest association Dfpsyc.holﬂglsis with more l:han 137.000 researchers, educators, clinicians. consultants and students as its members. Qur mission is to advance the
psseciation lcreation, comt 1 n and lication of psychol 1 knowledge to benefit society and improve people's lives.
lcBT \Cognitive Behaviour Therapy Self-Help ResourcesCognitive Behaviour Therapy (CBT) has been proven to help mental health problems. This website GET.gg offers
— ICBT self-help information, resources and including therapy worksheets on the FREE DOWNLOADS PAGES: worksheets & handouts

|A source and library of resources in counselling and psychotherapy includes in-depth book reviews, an annotated bibliography of books and articles. a guide to other
ICounselling Resource  [fresources on the web, and summaries of the latest news headlines in psychology and mental health. Information on clinical trials and mental health medications

research is available separately.
|Central Statistics Office ||Government body responsible for compiling Irish official statistics. Provides data and information on methodology.
Druss e Drugs.ie is an independent website managed by The Ana Liffey Drug Project. Our mission is to help individuals, families and communities prevent and/or address
J‘ probl::ms arising from drug and alcohol use. v

TV tie oA Sttt d Mot M Ao T Ao ZINEA &% o A AT ot o de oo b oot it d ot i b e

ol L€ @ R ES[E]E i

=Rl RN - RCRERCRN S S CRE

IMPORTANT NOTE

All of our Library services can only be accessed through the Student
Portal and by clicking on the related links. There is no point in
bookmarking the individual library resources as they can only be
accessed by first logging in to Moodle with your own username and
password and following the links on the Library Pages.
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MAIN RESOURCES

PSYCNET

PsycARTICLES—select this database to find full-text journal articles in subject areas such as applied psychology,
health, theory, research, social/personality, and more. Here you can find full-text articles from journals
published by the American Psychological Association, the APA Educational Publishing Foundation, the
Canadian Psychological Association, and Hogrefe Publishing Group. The majority of the journals in this
database are covered from the first volume published. With current journal coverage and historical content
dating back more than a century, this esteemed collection provides access to the full spectrum of research in
the field and is an indispensable resource for researchers, practitioners, students, and educators.

As well as unlimited access key benefits of PsycARTICLES are

Explore a convenient, single collection of APA journals, which offers complete article coverage back to
Volume 1, Issue 1 for most journals

Weekly updates and Online First indexing guarantee rapid access to the latest high-quality research

Articles are written by esteemed researchers from across psychology and the behavioral and social sciences,
presenting the latest scholarship to shape and inform research

Over a century of psychology coverage with articles from as early as 1894, chronicling the history and
development of psychology research over time

Download a printable information sheet (PDF, 63KB) about PsycARTICLES to learn more.

£ APA PSYCNET @ Avenican PScmotoGica ASSOCIATON

BROWSE TERM FINDER MY PsycNET

| Jin: ey e

=l |In: 7oy Beic v O Acssow

PsycARTICLES has a very powerful search facility and a number of
tools to help you quote and cite passages of text for your own work.
In the Help section of Psycnet you will find a range of step by step
guides and training videos that will help you make the most of this
repository.
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DAWSONERA

The platform provides access, on site at ICHAS and remotely, 24/7, to a tailored library of ebooks that you are

able to be read online or downloaded to your own PC.

Please note that this system works off credits so the following applies:
When you download the book, you will be able to use it for 24 hours
and this download is considered 1 credit. Please do not download the
same book twice as this will reduce the amount of credits that are
left.

Publisher ' Admin Contact

i dawsonera

Home About ebook Catalogue My Account Help Title, Author, Keywor b gg;?cnhced

You are here: Home > Search results

My Bookshelf o
Refine: Search Results (7] y
Tip: Add and remove favourites
g N from your My Bookshelf area by
Library availability: 27 results Sort:  Relevance -~ using the star icons nextto each
title
KB Owned by my library
S 8 : g3 Risk Management *
KB " Showunowned content Recently Viewed 0
Description
Recently added ebooks: Risk management is not just a topic for risk Mindfulness-Based Cogniti
g professionals. Managers and directors at all levels must ve Therapy
& Added in the last 30 days be equipped with an understanding of risk and the tools Pages: 201 *
and processes required to assess and manage it Author:
Format: successfully. "Risk Management' offers a practical and Rebecca Crane
E structured approach while avoi .. Publisher:
@ Taylor & Francis Ltd -
[
el MUA

Pages: 288
¥ EPUB Author: Paul Hopkin @
Publisher: Kogan Page Ltd - Psychological approaches
Year of publication: to generalized anxiety diso
1898-2015 ; * Lo
BTSN g3 Effective Customer Care Pages: 204 *

| e Ao
= Description Holly Hazlett-Stevens.

[e—
Publisher:
Springer Verlag

“Effective Customer Care" is an essential guide to
Reset Update 3 : 4
creating excellent customer service that will not only

You will have full access to any books owned by ICHAS in the Library. You will be able to view a list of these
books by clicking on the button at the top of the Dawsonera homepage. Books owned by
ICHAS can be recognised by the green open padlock icon.

Library availability:
The books owned by ICHAS, and available to all students, are either

core course texts or highly relevant supplementary reading, and are all &8 Owned by my library
valuable resources. We are continuously building the collection and &
new books are added regularily. KB '’ Show unowned content

The Help section of the Dawsonera website contains essential guides
and videos on how to get the best from this resource. We strongly
recommend that you read the basic guide before using the library.

Page | 24




SCIENCE DIRECT

This online service has quite a collection of good quality journals in various research areas. ScienceDirect is

Elsevier’s leading information solution for researchers, teachers, students, health care professionals and

information professionals . It combines authoritative, full-text scientific, technical and health publications with

smart, intuitive functionality so that you can stay informed in your field, and can work more effectively and

efficiently.

ScienceDirect requires that you
register and create a user
account. We will assign you a
registration ID and Password
that will allow you to register a
new ICHAS user account with
ScienceDirect. You will receive
an email, similar to the
example opposite, with your ID
and Password. Click on the link
to create your account.

The link will take you to a where you can enter your

H © O % ¥ 3 YourScienceDirect Registration ID - Message (Plain Text) ? H - O X
FILE MESSAGE ADOBE PDF
Y g -
& x CeReply Move to: 7 2] Yl B | Mark Unread || 8 Q
- Dl @_ Reply All S To Manager Ad| i _@ Editing| Z
- it ete E% Forward E-@ > ||&E Team Email 7] ?VE \:! . [> Follow Up~ . 9] Zoom
Delete Respond Quick Steps [ Move Tags [ Zoom ~

| Wed 04/05/2016 12:34
ScienceDirect Message Center <sciencedirect@prod.lexisnexis
1y Your ScienceDirect Registration ID
To  heew@ehernonsdetc.som
0 This message has extra line breaks.

You have been assigned a Registration ID for ScienceDirect which allows remote access outside your
institution.
Your Registration ID and Password information is as follows:

Registration ID: 232103. )
Registration Password: 211712

To create a Username and Password for ScienceDirect please enter this information at
http://www.sciencedirect.com/register.

You will be prompted to create a new user profile so you can begin using ScienceDirect.

Thank you for using ScienceDirect. If you have any questions about this or other features of
ScienceDirect, please access the ScienceDirect Info Site at
http://www.info.sciencedirect.com

0 See more about ScienceDirect Message Center. : { A

ScienceDirect Joumals  Books

Registration ID Redemption

Reg/strat,on ID and Password to start the process Of Registration IDs allow you to associate your ScienceDirect Username with a new organization and thus access ScienceDirect

creating your User Account.

features and content to which that organization has entitiements. As a first step, please enter your Registration ID and
Registration password befow, then click the Continue button

Note: Adding an association with 3 new organization wi not overmide or remove associations wih existing organizations.

Registration ID:
Registration Password:

I'm not a robot

ot
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At the next stage you will be presented with a screen similar to the one below. Please make sure you click on
the Register Now link only.

SCIenCEDIreCt Joumnals  Books
ScienceDirect -The world's leading full-text scientific database i
Registration IEJ ASsociation

| o -

Sign in usi Sci Direct cradentia OpenAthens login |If you do not yet have a ScienceDirect Username, you may
| Register Now.

This registration ID allows you to associate with Irish College Login via your institution

of Humanities and Applied Sciences, 2015-2018 Science »

Direct. To continue with the redemption process using your Other institution login

existing ScienceDirect Username, please sign in below. Remoke access activation

Click Here to
create your new
Science Direct
account

Click here to activate

¥/ Remember me
Signin | | Cancel

Forgotten username or password?

Follow the instructions on this page to complete your account creation.

ScienceDirect Joumals  Books

Activate User Account

Registration is quick and free. It allows you to personalize these Elsevier products if you have access. For example, you can

stay up-to-date with Search Alerts or keep track of your research with Saved Searches.

This registration form uses Google’s new reCAPTCHA test to prevent use by robotic programs. The new reCAPTCHA is designed to be
simple and accessible. A significant number of users will pass the reCAPTCHA challenge without having to solve a CAPTCHA Instead,
with just a single click they'll confirm they are not a robot. For the visually impaired, reCAPTCHA provides an audio CAPTCHA option. To
register without completing the reCAPTCHA test, please contact Elsevier Customer Support.

(* = required field)
Create a unique sign in to use in Elsevier products

‘Your details Privacy policy
First name: ‘ ‘ &
Family name: ‘ ‘ x
E-mail and password
Enter 3 password between 5 and 20 characters. Your e-mail address will be your username.,
E-mail address: ‘ ‘ *
Password: ‘ ‘ *
Confirm password: ‘ ) ] ‘ =

* Show alert & other settings

|l '+/ | wish to receive information from Elsevier B.V. and its affiliates concerning their products and services,

|_J* | have read and understood the Registered User Agreement .

I'm not a robot Q

Register If you are having problems registering, please contact us.

Please remember to take note of your password as you will need it to access the ScienceDirect full text
content. ScienceDirect has a comprehensive Help facility that will guide you through searching and saving
articles.
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ADOBE CONNECT (LIVE LECTURES)

INTRODUCTION

Adobe Connect is an integral component of the ICHAS Blended Learning Environment and affords students the
facility to engage with live module lectures as they happen. Not all lectures are suitable for broadcast and you
will be advised of broadcasts at the start of each semester. This should offer students a greater deal of
flexibility when planning their studies.

Before using Adobe Connect please refer to the Student IT Requirements at the start of this manual. It is also
essential that you perform the Adobe Diagnostic Test by clicking on the following link:

http://admin.adobeconnect.com/common/help/en/support/meeting test.htm

This diagnostic test will ensure your computer and network connections are properly configured to provide
you with the best possible Adobe Connect meeting experience. The diagnostic test checks for the following:

1. Clear connection to Adobe Connect
2. Bandwidth availability
3. Latest Adobe Connect Add-in

If all tests pass successfully, you are ready to log in to ICHAS Live and recorded lectures. However, if you
continue to experience problems, please contact our IT Support Services

Additional Information
If this is your first Adobe Connect meeting, you might want to take a few minutes to learn more.

e Visit ConnectUsers.com for a wealth of documentation and user community information.
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JOINING A LIVE LECTURE — ADOBE CONNECT

If you successfully completed the Adobe Connection Test you are ready to login to your Live Lecture.

There are two methods you can use to access your live lecture. Whichever method you chose please ensure

you login at least 15 mins before the lecture start time.

Method 1

Shortly before your Blended Module Lecture is due to commence you will receive an email through the

Moodle LMS containing a link to the Adobe Connect Lecture Room for your module. Just click on the link to

enter the room.

Method 2

Login to your Moodle account through the Student Portal www.ichas.ie

1. Choose the relevant module from the “My Courses” panel in Moodle
2. Under the heading “Live Lectures” you will find a link to your lecture

Example:

@) The Mental Health Continuum 26/03/2016
Click on link to enter the lecture. Please remember to wear your headset.

3. Regardless of the method used, when you click on a link you will be brought to
a login page for the lecture You do not need to input a username and password.
You only need to select the Enter as a Guest option and then input your full
name so that your lecturer and classmates know who you are. Then click the
Enter Room button, and the session will begin.
ADOBE" CONNECT"

Test Meeting - Wednesday 26th Sept

@ Enter as a Guest

G adobe connec: X | §J Adob

<« (e 711‘, students.icl

3% Apps QJ Harry Dickinson -

Cu

Settings

P My profile settings

My courses

$e Application of
Psychological and
Psychometric Assessment
(8170. 8212, 8168)

%+ Application of
Psychological and
Psychometric Assessment
(8340)

%2 Application of
Psychological and
Psychometric Assessment
(8390)

%2 BA Programmes

%2 Cognitive and
Behavioural Approaches in
Therapeutic Interventions
(8504)

for Youth Work (8361)

for Youth Wark (8388)
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SETUP TO ENGAGE WITH THE LECTURE — ADOBE CONNECT

When you login you will be presented with a screen similar to the one illustrated below. The widow is arranged
in a typical fashion: a Menu Bar at the top providing access to some of the main functions, a Side Panel
displaying the Camera View, Participants and a Chat Pod. The Main pane will display Powerpoint Presentations
and other documents your lecturer wants to share.

H Assessment Knowledge Management 27/04/2016 - Adobe Connect X

@ Meeting Wl T s

Video (1)

Turn Speaker Ra:;&ou
On or Off

The Meeting Turn Microphone
button gives you On or Off
access to Prefer-
ences and the
Audio Setup

Live Lecture
Webcam view [

Slide Presentstion
area - 4
s

Attendees (3)

Introduction to Adobe
Connect

@ 1cHas1 Q
v Hosts (1)

& 1cnas1 &

» Presenters (0)

Click on a name
to private chat
with someone

v Participants (2)
PR & Horry Dickinson

8 iams12 &

Student Guide

Chat (Everyone) =-

Type here to chat
with everyone %

)< ICHAS

Irish College of Humanities & Applied Science

13:41
27/04/2016

A~ 4) B ;e
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BEFORE YOU START

This setup can be done any time prior to your participation in an Adobe Connect meeting, but
we do recommend that you login and test your settings. It is strongly advised that you avail of
one of our “Test Sessions” so that you can go through ALL the steps below, before your join
an actual real Live Lecture session. This will allow ample time for troubleshooting any
technical problems.

NOTE: As previously stated in the Student IT Specifications, to use the audio features of Adobe Headset

Connect, you need to have a suitable Microphone Headset. Your induction pack will contain details

of recommended Headsets and where to obtain them.

Once you have all the needed components installed and BEFORE entering your meeting session,
make sure:

e headset is plugged in
e preferably using wired internet access instead of WiFi
e login only once

SETTING UP YOUR AUDIO

Before participating in a class, you will be required to set up your Audio. You can do this using the Audio Setup
Wizard that automatically guides you through the setup and tuning of audio device settings. If the audio does

not work properly, the wizard offers help with troubleshooting tips.

Meeting

1. First, you will need to choose the way your computer connects to the audio in your Manage Meeting Informatid

Adobe Connect meeting. For instance, if you plan to use a headset with a microphone, Mbiags Koceds £ Enin

plug the device into your computer. Click on Meeting and then on Audio Setup Change My Role

Wizard to check audio settings.

Preferences...

Audio Setup Wizard...

2. The wizard guides you through a few steps that test your speakers, let you select a

microphone and optimize your audio. If you have never used Adobe Connect before, Record Meeting...

you may see a Flash Player settings box asking for permission to use your camera and Switch To Prepare Mode
microphone. Selecting Remember will skip this prompt in the future. If you don’t plan Enable Presenter Only Area
to speak in the course, the host may not enable your audio. Full Screen

Therefore, even if your microphone works, you may not get a chance to use it. Use the End Meeling...

Help button at any point if the audio does not work as expected. :
Exit Adobe Connect

SPEAKER ICON BUTTON

If your speakers provide sound from the meeting, your speaker icon will

become green, as shown in the image below.

Mute My Speakers

The speaker drop-down menu also has an option to Adjust Speaker Volume
Mute Conference Audio Only within the meeting. Use this option if you prefer louder or softer audio,
Adjust Speaker Volume... although you may need to adjust the master volume settings on your

computer as well.

Page | 31




MICROPHONE ICON BUTTON

Connect My Audio

Your lecturer may allow you to use the microphone during the class,
allowing you to speak in the classroom. When this happens, a black box
will appear in the top right corner of your screen, alerting you that you
have had Voice Rights granted. To enable your microphone so you can
speak in the meeting, click on the white microphone icon. Once the icon

becomes green, it means that your microphone is live and you are broadcasting sound in the meeting.

Unless you need to speak, YOUR MICROPHONE SHOULD ALWAYS BE MUTED as it is likely powerful enough to

broadcast all ambient noise in your surroundings, which may disrupt the lecture.

To mute your microphone, click the green icon so that the image changes to show a line through the

microphone.

RAISE HAND/STATUS ICON BUTTON

The Raise Hand icon allows you to raise your hand electronically in the meeting, alerting the
lecturer that you have a question. To activate this option, simply click the Raise Hand icon.

To use the other status icons in Adobe Connect, click the drop-down arrow next to the Raise
Hand icon and select an icon from the following options: Agree, Disagree, Step Away, Speak
Louder, Speak Softer, Speed Up, Slow Down, Laughter and Applause.

The appropriate icon will then appear next to your name in the attendees pod list, which allows
other room attendees to see your status.

If you select an option above the line such as Agree or Step Away, your status remains until you
choose Clear Status. If you choose an option below the line such as Speed Up or Applause, your
status automatically clears itself after a few seconds.

HELP BUTTON

0

0

OE AT

Raise Hand
Agree
Disagree

Step Away

)) Speak Louder
Speak Softer
% Speed Up

B e L

@ Slow Down
'1';5' Laughter
= Applause

m The Help button is located to the far right of the menu bar, which contains links to

Adobe Connect Hel
¥ keyboard shortcuts.
Connect Basics
Keyboard Shortcuts
Troubleshooting

Downloads
Connect iher Cammunily if any known issues exist.
Check System Status
Contact Support

About Adobe Connect...

a number of resources, including troubleshooting tips, Connect basics and

A link to Check System Status is also available. A page appears with a report on
the Adobe Connect system. If you think the system does not work, you can verify
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CHAT POD

The chat feature allows multiple windows in a single pod, tiled across the bottom of
the pod. Initially, you will only see a chat labelled Everyone, and as you add
additional chats, they will appear to the right of your Everyone chat. You may open
a separate chat window for each user or have one chat addressing a role (i.e., hosts
or presenters).

By using the Pod Options button in the top right corner of the chat pod, you can
elect to show time stamps in the chat, change your chat color or increase the text
size in the chat. For easy reading, choose a size 12 or 13 font for chatting.

To type a message in the chat pod, simply enter text in the long rectangular field; to
publish your text to the room, click the enter or return key, or select the button with
the chat bubble. When you receive a new message in a chat window, the window
blinks yellow but does not give an audio alert.

Chat (Eve wg

The chat histg ~ Start Chat With

Text Size »
My Chat Color P

Help

I 2

Everyone |

Use the Pod Options button in the top right corner of the chat pod to see other chat options. To begin a

private chat with any hosts, presenters or other attendees in the meeting, click the Start Chat With option and

then select the group or person with whom you would like to chat privately. To change your text size or chat

colour, click the option Text Size or My Chat Color and then select one of the available options. Clicking Help

will direct you to the Adobe Connect resource page on chat in meetings.
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Troubleshooting and
Frequently Asked Questions

Problem

Possible Solution

| cannot join the meeting.

Enter the meeting as a guest user by entering in your first
and last name in the guest field.

Click the help link on the meeting login page. This takes
you to the test meeting connection page, where you can
verify that your computer meets all necessary
requirements. If you do not pass the test, the page will
give you further instructions.

Make sure your browser’s pop-up blocker is not blocking
your meeting window.

You may be using a proxy server. To resolve this in
Internet Explorer, select Tools > Internet Options >
Advanced tab. Then enable the setting “use HTTP 1.1
through proxy connections.” Then, clear your cookies,
close all browser windows and attempt to re-enter the
meeting.

| cannot hear any audio.

Verify that your computer speakers are turned on and
your computer’s volume is set at an audible level.
Check to ensure you have not muted the meeting audio
(check that the speaker icon is still green).

| cannot speak in the meeting.

Verify that you have been granted speaking rights (check
if the microphone icon appears in you menu bar at the
top).

Select the audio setup wizard to determine microphone
functionality.

| have been granted rights to speak, but no
one can hear me.

If you have trouble sharing your voice, try the following:
Make sure your computer microphone is not muted.

Run through the audio setup wizard. Select Meeting >
Audio Setup Wizard. The wizard guides you through five
steps to tune your computer for optimal VolIP.

You may have elected to deny the Flash Player access to
your computer’s microphone. To verify this, right-click in
the meeting window and choose Settings to view your
Flash Player settings. In the dialog box, choose Allow.

The host is sharing his or her screen, but it
is fuzzy.

If you have trouble seeing a host’s screen, try the
following:

If you have trouble seeing a host’s screen, try the
following:

Click the Full Screen button on the top of the share pod.
View the full resolution. Go to the pod options menu in the
top right-hand corner of the pod, and select Change View
> Zoom In.

The audio is echoing.

Verify that you have muted your microphone.
Check that you do not have two sessions open at the
same time.
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INTERNET ACCESS

ICHAS provides free WiFi access for all students, full and part-time, studying at either our Limerick or Dublin

campus. Login and password details will be in your induction pack.

WiFi Coverage map for ICHAS College Limerick

NOTE

This is a fully managed enterprise WiFi network. Please note that that
each individual device is limited to a 3Mbps Download Speed and
1Mbps upload speed. These caps are in place to ensure fair usage is
maintained. Devices found to be downloading excessively large
amounts of data, movies etc. may have their access further limited.
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